
RailCommander 0.1 Manual

DCC4PC

This manual covers topics which are useful for the everyday use of RailCommander. This includes
numerous examples which demonstrate techniques for using the software in a range of ways.

1 What’s New?

Version 0.1 is the first version of RailCommander to be released to the public. Currently, RailCommander
is available for Windows XP, Vista and 7.

This release of RailCommander allows users to create, edit and run layouts using a PC. Many additional
features are planned for the next release. A list of the main features in the current version is given here:

• Scripting

• Automatic block control

• Manual point/signal control via RailCommander

• Track Editor using smooth curves

• Multiple layout views

• Background image loading

• Support for points and signals with an arbitrary number of states

1.1 Planned Features for Future Releases

The list below contains some of the features which will soon be added to RailCommander:

• Animated function icons

• Angle snapping for the Track Editor

• Many more script commands

• Custom attributes to create groups for scripting, e.g. tunnel zones, passenger/goods trains

• Simulation mode to test scripts and automation

• Scale and measurement system to allow accurate layout reproduction

• More signal variations and signal presets

• Locomotive consisting

2 Installation and Setup

For simplicity, an installer package is provided. Double-click on RailCommanderInstall.exe and choose
the installation folder when prompted.

Also note that the software is portable. i.e. no files need to be added to your system folder or keys
added to your registry so RailCommander can effectively be installed in a new folder simply by copying
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or moving the RailCommander folder. This is particularly useful because the RailCommander folder
may be copied onto and run from a USB flash drive.

2.1 Trial Period

RailCommander comes with a trial period of 100 hours of active usage. The trial timer will not count
down unless the software is running. After the trial period ends, the user will have to purchase a licence
in order to continue using RailCommander. During the trial period, the user will be able to access all
functions of the software without restriction.

2.2 Purchasing a Licence

Licences are created to match a particular installation of RailCommander, specifically, the unique ID
which is generated by each installation. To find your unique ID, open RailCommander and go to
File > Activate. Alternatively, if the trial period has already expired, the unique ID will be displayed
on the information screen when you open the software. In order to purchase a licence, send an email to
dcc4pc@gmail.com with the software’s unique ID. Payment details will be provided and your activation
code will be sent to you on receipt of payment.

2.3 Updating to the Latest Version

New versions of the software will be made available from time to time as new features are added and/or
bugs are fixed. The new versions may be downloaded here. The version number of your installation of
RailCommander is shown in the title bar.

2.4 Uninstalling RailCommander

If you have previously purchased a licence, you can reclaim it prior to uninstalling and the same licence
can then be used again for a new RailCommander installation. This may, for example, be necessary
when moving the software to a new computer but is not needed when upgrading to the latest version.
To reclaim the licence, go to File > Activate and click the ‘Revoke’ button. A small window will open
with a Revocation Code. Email this code to dcc4pc@gmail.com and we will then record that you have
an unused licence in your name. You can then install RailCommander at any time in the future and we
will send you a new activation code when we receive your new installation’s unique ID.

To uninstall RailCommander, simply delete the RailCommander folder. If you installed the software
in the default location the RailCommander folder will be C:\Program Files\RailCommander for 32-bit
versions of Windows and C:\Program Files (x86)\RailCommander for 64-bit versions of Windows.

3 The User Interface

RailCommander operates in two modes: Track View and Track Editor. Each has a slightly different
user interface but with many common elements. Like most conventional software, RailCommander has
a Menu Bar at the top with a Tool Bar below and the main working area occupying most of the rest of
the screen. The items in the Menu Bar and Tool Bar differ depending on whether the current window
is a Track View window or a Track Editor window. Note that it is permissible to have both Track
View windows and Track Editor windows open at the same time if desired. The panel on the right of
the window is the Object Browser which incorporates the Properties Panel for each object in a layout.
RailCommander can refer to various different items, e.g. locomotives, points, zones, scripts, etc. and the
collective term ‘object’ is used to refer to these when no more specific term is appropriate.
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3.1 Track View

The Track View window is used to run layouts after they have been created in the Track Editor window.
When RailCommander is closed, it remembers the currently open layout file and will open it again on
startup in a Track View window. If no previously opened layout file exists, RailCommander will start in
a Track Editor window.

3.1.1 Menu Bar

File:
New Creates a new blank layout
Open Opens an existing layout file
Save Saves the current layout file
Save As Saves the current layout file with a new name
Activate Opens the Activation window
Close Closes the current window
Quit Closes RailCommander

View:
Track View Opens a Track View window
Track Editor Opens a Track Editor window
Throttle Opens a Throttle window

Block Control:
Enable Block Control Enables/disables automatic block control

3.1.2 Tool Bar

New Creates a new blank layout
Open Opens an existing layout file
Save Saves the current layout file
Save As Saves the current layout file with a new name
Track Power On Applies power to the layout tracks
Track Power Off Cuts power to the layout tracks

3.2 Track Editor

The Track Editor window is used to edit layouts. When RailCommander is closed, it remembers the
currently open layout file and will open it again on startup in a Track View window. If no previously
opened layout file exists, RailCommander will start in a Track Editor window.

3.2.1 Menu Bar

File:
New Creates a new blank layout
Open Opens an existing layout file
Save Saves the current layout file
Save As Saves the current layout file with a new name
Activate Opens the Activation window
Close Closes the current window
Quit Closes RailCommander

View:
Track View Opens a Track View window
Track Editor Opens a Track Editor window
Throttle Opens a Throttle window
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3.2.2 Tool Bar

New Creates a new blank layout
Open Opens an existing layout file
Save Saves the current layout file
Point Creates a new point object
Signal Creates a new signal object
Scissor Point Creates a new scissor point object
Zone Creates a new zone object
Crossing Creates a new crossing object
Label Creates a new label object

3.3 Throttle Window

The Throttle window allows the user to specify a locomotive and to control its speed and functions. A
dial indicates the set speed of the locomotive with a red needle and, if supported by the decoder, the
true speed (as reported by RailComTM) with a black needle. The green arrow below the speed slider
changes the direction of travel and the ‘stop’ sign allows the user to send an emergency stop signal to
the current locomotive. If there are no locomotives defined then the buttons are greyed-out and cannot
be used. Once locomotives have been defined (see Editing Locomotives) then the current locomotive can
be chosen from the drop-down selection box. Any functions setup for the current locomotive will appear
at the bottom of the Throttle window.

3.4 Views

Given that it is not always practical to control the entirety of a model rail layout from a single layout view,
RailCommander supports multiple Views of the same layout. For example, it may be advantageous to
have a fiddle yard in a separate view to the rest of the layout or for a sectioned layout to have a separate
View for each section. Each zone in the layout may exist in all, some or none of the Views. Note,
however, that each functional zone needs to be present and connected to the appropriate neighbouring
zone(s) in at least one View in order for RailCommander to accurately run the layout. Note also that
when a node is known to be linking two objects in the layout, instances of those objects in other Views
will also appear with the corresponding nodes shown in blue regardless of whether the objects appear to
be linked in the current View.

New Views are added to a layout file via the Object Browser. Click on the ‘All’ tab in order to view the
Layout Hierarchy and highlight the ‘Views’ group. Click on the ‘New View’ button that appears below.
A new View is added to the layout and may be given a unique name in the Properties Panel. The user
may switch between Views in both the Track Editor and Track View windows by using the tabs below
the current View window.
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3.5 Object Browser

The Object Browser has two modes which can be switched between by clicking the ‘Selected’ and ‘All’
tabs at the bottom. As the name suggests, the ‘Selected’ mode tracks the current selection and shows
the relevant properties for that object. The ‘All’ mode is made up of two parts: the Layout Hierarchy
at the top and the Properties Panel below it. The Layout Hierarchy shows the full list of objects in the
current layout file regardless of whether there are instances of all objects in any of the layout Views.
This is also where more abstract objects such as scripts can be accessed. Any object can be deleted from
the layout file by clicking the small ‘×’ icon to the right of the Layout Hierarchy. The contents of the
Properties Panel is dependent on what is highlighted in the Layout Hierarchy. When an object group
such as ‘Points & Signals’ is highlighted, the Properties Panel allows the user to add new objects. For
objects themselves and their components, their properties are displayed and can be edited.

4 Creating and Editing a Layout

4.1 Creating a New Layout

A new, empty layout can be created by clicking the ‘New’ icon in the Tool Bar, selecting File > New
from the Menu Bar, or using the keyboard shortcut Ctrl + N .

4.2 Adding Devices

Adding a device is a very simple process. In most cases there is no, or very little, setup required.
Whenever possible, devices are auto-detected when they are connected to your PC and a suitable device
is added to the layout automatically. For example, if a Lenz LI-USB is connected to a computer while
RailCommander is running, a device named ‘Lenz LI-USB 1’ will appear under ‘Devices’ in the Object
Browser. When a device needs to be set up, the Properties Panel can be viewed by highlighting it in the
Layout Hierarchy.

The following hardware is supported by RailCommander:

4.2.1 DCC4PC Computer Interface Device

This device is detected and configured completely automatically. When plugged in for the first time the
software will begin a scan for attached Omnibus devices. A fresh scan may be started at any time by
clicking the ‘Scan for Omnibus Devices’ button in the device properties in the Object Browser.

4.2.2 DCC4PC RailComTM Reader

This device is detected automatically. To configure the device, you must tell it what the source of its
DCC signal is. By default, the DCC source is set to the Default device which should work in most cases.
The DCC source can be changed in the device properties in the Object Browser.

4.2.3 ESU ECoS

This device is a network device and cannot be autodetected or automatically configured. Therefore, a
new ESU ECoS device needs to be added to the layout via the Layout Hierarchy: highlight ‘Devices’ and
use the ‘New Device’ button and select ‘ESU ECoS’ from the list. The network address of the device
needs to be entered before it can be found by RailCommander and used. No further configuration is
required.
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4.2.4 Lenz LI-USB

This device is detected and configured completely automatically. Note that new LI-USB devices are
setup as Default devices and will send commands to locomotives and points which have not been set to
use a specific device.

4.3 Editing Zones

A ‘zone’ is a representation of any section of track which has a single entry point and a single exit point.
i.e. zones are used to link points together (or other zones when they are being used for block control).
The only exceptions to this definition are crossings, which requires no automation except block control.
Crossings are treated as a single zone object by RailCommander. There are two ways to add a zone to
a View: from the Tool Bar or from within the Object Browser. To use the Tool Bar, simply click on the
Zone icon and click again in the View to place it. Zones added in this way are given a default name.
To use the Object Browser, switch to the ‘All’ tab and select the ‘Blocks’ group. Click on the ‘New
Zone’ button that appears. Expand the ‘Blocks’ group and select the newly created zone. In the new
zone’s properties you can give it a unique name and add an instance to the layout using the drop-down
selection box indicated by a small down-arrow to the right of the ‘Zone’ icon in the Tool Bar. Crossings
can also be added and edited in these ways.

By default, a newly added zone comprises only two nodes connected by a straight line. The grey colour of
the nodes indicates that they are not linked to any points or other zones. The nodes can be manipulated
by clicking and dragging on them. Clicking and dragging on the line connecting the nodes adds a new
node at that location. Note that crossings cannot be given extra nodes. A straight line can be changed to
a curved line by right-clicking on it and choosing ‘Curved Line’ from the menu. The reverse is achievable
by choosing ‘Straight Line’ from the menu. Curved lines are manipulated by moving the green bezier
control nodes. Note that nodes bridging a curved and a straight line enforce tangency and thus the
bezier handle will remain collinear with the straight line. Bezier handles on nodes spanning two curved
lines are not constrained in this way but the orientation of the node may be fixed by right-clicking on
the node and selecting ‘Lock Angle’ from the menu.

To link two zones, click and drag one of the zone’s end nodes onto one of the other zone’s end nodes while
holding Ctrl . Release the mouse button when the nodes snap together. Successfully connected nodes
appear blue in the Views. Note that new instances of two mutually linked zones will appear with blue
connected nodes regardless of whether the connected nodes visually coincide in all Views. Two zones
may be disconnected by right-clicking on the connecting node and selecting ‘Disconnect’ from the menu.

When selected, a zone’s properties will appear in the Selected tab of the Object Browser. A zone may
be renamed here, assigned an occupancy or RailComTM detector, or be set to swap the orientation of
RailComTM signals.

4.4 Editing Points and Signals

Conceptually, points and signals are objects which can be switched between two or more ‘states’ where
the states will depend on the point or signal in question. For example, a semaphore signal could have
‘Raised’ and ‘Lowered’ states, a point could have ‘Straight’ and ‘Curved,’ or possibly ‘Left,’ ‘Middle’ and
‘Right.’ RailCommander requires that all points and signals have at least two states (it is difficult to
imagine a use for a one-way point), but doesn’t impose any maximum limit. Scissor points behave very
similarly to standard points, but always have precisely four states and, of course, a different shape.

To add a point to the layout, click ‘Point’ on the Track Editor toolbar, then click to drop the point in
the view. If you want to show the same physical point in two places, you can click on the drop-down
arrow next to the ‘Point’ toolbar button. This is useful when drawing a second view which shows some
of the same track as the first. Adding scissor points and signals is achieved in using the ‘Scissor Point’
and ‘Signal’ buttons in exactly the same fashion.

Points are edited in the same manner as zones. Drag the grey nodes at the ends of the track sections
to move parts of the point. Hold down Ctrl to link the ends of the point to other track sections. Like
zones, individual segments of the point may be either straight or curved, however in a point only one
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of the segments may be straight at any one time. To change the current setting of a track segment,
right click and select ‘Curved Line’ or ‘Straight Line’ from the menu. If you attempt to change a line
to straight when the point already has a straight segment, the previously selected straight segment will
automatically become curved. Curved track segments can be adjusted using the green diamonds which
appear when the point is selected.

When a curved section of track and a straight section meet, the angle of the curved section is forced to
match that of the neighbouring straight section, to ensure the lines join smoothly. Neighbouring curved
sections do not have this restriction, but can be locked to their current angle by right clicking on the
node and selecting ‘Lock Angle.’ This can make it easier to get the shape of certain sections of track
correct.

Signals display images to indicate their current state. The images are selected in the properties for
the signal’s states (found underneath the signal in the Object Browser). RailCommander comes with a
selection of signal images for this purpose. The signal may be dragged to move it to a different position
on the layout. As signal images are not resized at different zoom levels, an option is provided to select
which part of the signal image has a fixed position when resizing. The centre of the signal, the four
corners, and the centres of the sides of the signal may be selected. For example, if the signal is placed
above a track section, then selecting that the bottom of the signal should be fixed would make sense.
Signals also have an angle setting which can be used to rotate the signal images to match the angle of
the track it is placed along side. These properties are found by clicking on the signal and switching to
the ‘Selected’ tab.

In order to switch a point or signal RailCommander needs to know how the motor is wired to the layout.
As far as RailCommander is concerned, there are four ways a motor can be connected:

Basic Accessory This is the most common type of point controller by far. A basic accessory decoder
is a module with up to four outputs, each of which can be switched between two states (left or
right).

Extended Accessory An extended accessory decoder is a module which supports switching between
anywhere from 2 to 32 states. It is up to the manufacturer to determine how these states translate
to motors/lights/etc. on the layout. This makes them ideally suited to controlling some of the more
complex signal types. Unfortunately they are exceptionally rare in practice and very few command
stations support sending the commands to control them.

Locomotive Function A locomotive decoder’s function outputs can be used instead of a point decoder
for controlling a point or signal. They are a good option for switching lights in signals where the
pulsed output of most point decoders is unusable without extra circuitry.

Servo If a servo motor is connected to RailCommander via a servo controller board then this type may
be used to select the servo output to be controlled. A point decoder which happens to have servo
outputs does not qualify, as RailCommander still has to send basic accessory DCC commands to
control those. This type specifically refers to servos connected to the computer without going via
the tracks. The DCC4PC Switchboard is an example of such a device.

By default, when a point or signal is created, it is configured to use one basic accessory decoder with
address 1, and to use the first output of this decoder. The point/signal will have two states, configured
to switch the decoder left or right. Consequently, in most cases, all that will be required to configure a
new point or signal is to set the ‘Address’ and ‘Output’ options in the properties to the address of the
point decoder and the output (from 1 to 4) to which the point or signal is attached.

To configure a point/signal with a different type of decoder, choose the type from the ‘Type’ drop-down
box. The other properties will change to match the settings required for the selected type. For extended
accessory decoders, only an address is required, so ‘Output’ disappears. For locomotive function decoders,
the address becomes a locomotive decoder address (including the option to select long addresses) and
‘Output’ becomes ‘Function’ to select the function number used for the point/signal. Servos don’t have
any properties besides device, which is used to directly select the servo to be controlled.
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For the non-Servo types of decoder, ‘Device’ selects the DCC device to which the DCC signal is sent.
Generally leaving this set to ‘Default’ is the correct thing to do. Where this setting is useful, is if you
have a second command station which you have dedicated solely to controlling your points, leaving the
main command station to control your locomotives.

More complex points and signals generally use multiple motors to set their various states. For example, a
three-way point will usually use two motors, with the first switching between ‘Left’ and ‘Middle+Right’
and the second switching between ‘Middle’ and ‘Right.’ To configure such a point, you will need to tell
RailCommander about the second motor, and what pattern of left and right for each motor correspond to
each state. Semaphore signals with multiple arms on the same mast are another example where multiple
motors will be required for a single signal.

The default point created by RailCommander has one accessory decoder. To add a second, click the ‘+’
button next to ‘Decoder’ in the point’s properties. Each accessory decoder associated with a point is
assigned a number starting from one and counting upwards. By changing the number to the right of
‘Decoder’ you can switch between the different accessory decoders and modify their properties. In the
three-way point example above, you would click ‘+’ once, set decoder 1 with the address of the first
motor, and decoder 2 with the address of the second motor.

The next step is to click the ‘Add State’ button in the point properties to add a third state to the point.
The point now has two motors configured and three states called ‘Straight,’ ‘Curved’ and ‘State 1.’
Whilst there is no harm in leaving these names as is, it makes sense to give them more suitable names.
To do so, click the arrow to the left of the point in the Object Browser if it isn’t already open, and click
on one of the states below the point. A new name can now be typed into the ‘Name’ box. Once all
three states have been renamed you now have a point with three states ‘Left,’ ‘Middle’ and ‘Right’ (or
whatever names you choose). Now all that remains is to tell RailCommander that

Motor 1 Motor 2
Left: Left —

Middle: Right Left
Right: Right Right

To do this, select each of the states in the Object Browser and, in the list below, select Left or Right
for each of the decoders you configured earlier. When a decoder’s position for a particular state doesn’t
matter, you can untick the box at the left of the decoder’s entry to disable it. Disabled decoders don’t
get sent any commands when the state is activated. If you selected a different decoder type for any of
the decoders, then the corresponding entry in the list will adapt to allow you to enter the appropriate
information. Specifically, extended accessory decoders require a number between 0 and 31, locomotive
functions can be set either ‘On’ or ‘Off’ and servos require an angle in degrees between −90◦ and +90◦.
Four state signals and other more complex possibilities can all be set up in the same way. Just add as
many decoders as you need, give them addresses, and tell RailCommander how each decoder should be
set for each state.

4.5 Editing Locomotives

Locomotives differ from most other objects in that they are not ‘placed’ in the a View. Rather, defining
locomotives provides a database for use by RailCommander. To add a new locomotive, select ‘Locomo-
tives’ in the All tab in the Object Browser and click the ‘New Locomotive’ button below. All currently
existing locomotives will appear under the ‘Locomotives’ group.

To access the properties of a locomotive, select it in the Object Browser. The properties will appear
in the Properties Panel below. Within the Properties Panel a locomotive may have a function added
using the ‘New Function’ button at the top. The name and the top speed may also be changed here.
The remainder of the locomotive properties are grouped under the ‘Decoder’ heading and deal with
communication with the RailComTM decoder.

The ‘Type’ drop-down box allows the user to select the number of speed steps desired (most modern
decoders support 128 speed steps so the ‘Type’ should be left as default unless another setting is required).
The ‘Address’ box refers to the address of the locomotive decoder and should match the address assigned
to the locomotive. For long addresses, tick the ‘Long’ check box. In most cases, the ‘Device’ should
be left as default. Otherwise, a specific device for producing the DCC signal can be assigned here. If
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desired, speed and direction DCC commands can be disabled by unticking the ‘Enable Speed/Direction
Commands’ check box. This could be useful for ‘function only’ decoders. The ‘Speed’ box allows users to
limit the top speed of a locomotive to the specified value and the ‘Reverse’ check box swaps its effective
forward and reverse directions. Note that these properties need to be defined for each decoder within
each locomotive. To adjust the number of decoders assigned to a locomotive, use the ‘+’ and ‘–’ buttons
and the spin box at the top of the ‘Decoder’ section to switch between decoder Properties Panels.

A locomotive’s functions may be accessed by expanding the corresponding locomotive’s entry in the
Layout Hierarchy. The Properties Panel for each function allows the user to change its name (which
will appear in the Throttle window) and the function type: ‘Toggle Function’ for persistent operation
functions or ‘Pulse Function’ for momentary operation functions. The decoder containing the function
and the function number can be changed here too. The ‘Off Image’ and ‘On Image’ allows the user to
specify images to appear on the appropriate function button in the Throttle window. If only one of the
two possible images is defined, it serves as the function image regardless of whether the function is on
or off.

5 Scripting

5.1 Adding Scripts

A new script may be added to a layout by selecting ‘Scripts’ in the Object Browser and clicking the
‘New Script’ button. New scripts will appear in the Object Browser labelled ‘Script 1’, ‘Script 2’, etc. In
the Properties Panel there is an ‘Edit Script’ button which will open up the selected script in the Script
Editor window.

5.2 The Script Editor Window

Within the Script Editor window there are two greyed-out placeholders for the two parts that make up
a script. The first part of a script is the condition(s) which triggers the script. The second part is the
command(s) to be run when the script is run. Commands are always indented and are placed below the
script condition(s). To add lines of code to the script, highlight either of the two placeholder lines by
clicking on it and click again for a list of possible conditions. Choose a condition from the list. Note
that, in this release, the block occupancy condition is the only available condition. A line of code using
a mix of bold and non-bold type appears in place of the placeholder. Clicking on the bold parts of the
script line while it is highlighted allows the user to change its parameters by selecting options from a
drop-down box. Any script line can be deleted by clicking on the appropriate ‘×’ on the right-hand side
of the Script Editor window. Commands are defined in exactly the same way. Note that the order of the
conditions and the commands can be changed using the green arrow buttons on the right-hand side of
the window. It is always the highlighted script line that is affected. The Script Window is closed using
the ‘Close’ button below. Changes made to the currently open script will automatically be saved.
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6 An Example Layout

Here is a drawing as may be found in a magazine of a track layout.

Here is the same layout with tracks, points and signals added using the RailCommander Track Editor.
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7 Frequently Asked Questions

1. Can RailCommander be used with a DC layout?

No, RailCommander is focused on automation and requires DCC in order to work.

2. Will RailCommander work with hardware from another company?

For supported hardware, yes. Currently, RailCommander supports the ESU ECoS, the Lenz LI-
USB and all products made by DCC4PC. The list of supported hardware will expand over time.

3. How do I set up block control?

Block control is set up completely automatically. Just create a layout and define your locomotives.
RailCommander will do the rest.

4. What is the difference between Remove and Delete?

It is possible to show the same object in several different views, or even in the multiple places in
one view. ‘Remove’ will remove the object from just one location, any others will remain where
they are. ‘Delete,’ on the other hand, will remove the object from the layout entirely, causing it to
disappear from all views and the Layout Hierarchy.
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